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GETTING STARTED
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1. DeviceAnywhere Studio System Requirements  
DeviceAnywhere Studio can be run on most standard computer configurations.  

� 2 GHz Pentium 4 processor  

� 512 MB RAM 

� 10 GB Hard Disk Drive available 

� Java JRE 1.6 or greater (note: during the DeviceAnywhere Studio 
installation process, your system will be checked for this software, and it 

will automatically be downloaded if required) 

� Monitor that is capable of a 1024x768 screen resolution 

� Broadband Internet connection recommended 

� Optional: Audio card for sound input/output 
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2. Getting Started 
Go to http://www.DeviceAnywhere.com. 

Figure 1: http://www.deviceanywhere.com/ 

If you have received an email from Mobile Complete with your account information, log in at the 

upper right side of this page. If you do not already have your account information, click on the 

“Try it NOW and get 3 Hours FREE” button or one of the partner VDL trial buttons found at 
www.DeviceAnywhere.com, and sign up for a free trial. You will soon receive an email with your 

login information, and you can proceed to login as mentioned above. 
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Once you have logged in, you will see the MyDeviceAnywhere web pages. On these pages you 
can view account information, see saved files (uploaded frames, test results), and also launch 

DeviceAnywhere Studio. 

DeviceAnywhere Studio, a Java Swing application, is Mobile Complete’s main User Interface (UI) 
for interaction with DeviceAnywhere’s live test devices. It remotely connects over the Internet to 
devices that are located at various locations around the globe. 
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3. Installing and Launching DeviceAnywhere Studio 

 

 

Figure 2: Launching DeviceAnywhere Studio 

Once you are logged into DeviceAnywhere, click the Launch DeviceAnywhere Studio button in the 
upper-right corner to download and launch DeviceAnywhere Studio. 

3.1. DeviceAnywhere Studio Download 

When you click the Launch DeviceAnywhere Studio link, your system will be checked 
for the required version of the Java Runtime Environment (JRE).  

 

 Figure 3: DeviceAnywhere Studio Checking for Latest Version 

If the required version is already installed on your system, DeviceAnywhere Studio 
will begin to download. If the necessary version is not found, JRE will automatically 

be installed as part of the DeviceAnywhere Studio installation process. The initial 
launch of DeviceAnywhere Studio will take 3-4 minutes because it is uploading the 
device information for the first time. Subsequent launches will be faster. 

As soon as the DeviceAnywhere Studio download is complete, you will be asked if 
you want to create desktop shortcuts for DeviceAnywhere Studio. Please select ‘Yes’ 
when prompted. This will create DeviceAnywhere Studio icons on your Desktop and 
Start Menu. In the future, you can launch DeviceAnywhere Studio using these 
shortcuts. 

3.2. Login to DeviceAnywhere Studio 

DeviceAnywhere Studio will launch after the download and installation is completed. 
It will start by prompting you with a Login dialog box. Please use your assigned 

account information to log into DeviceAnywhere. Note that if your company uses a 
proxy, you may have to enter proxy settings by clicking on “Proxy >>” before 

logging into the system. Please consult your IT department if unsure. 
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Figure 4: Login to DeviceAnywhere Studio 

As soon as the DeviceAnywhere Studio download is complete, shortcuts will be 
created for DeviceAnywhere Studio on your desktop and Start Menu. In the future, 
you can launch DeviceAnywhere Studio using these shortcuts. 

 

NOTE: Depending on your Web browser security settings, you may see a Security 
Warning asking whether you trust this content from Mobile Complete, Inc. Please click 

“Yes” or “Always” when prompted.  

3.3. Monitor Screen Resolution 

Your screen resolution must be set to a minimum of 1024 by 768 pixels. We 

recommend setting your screen resolution to 1280 by 1024, or greater. 
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4. DeviceAnywhere Studio Interface 
Once logged in to DeviceAnywhere Studio, you will see the Device Access window as the default 
view. Device Access allows you to interact with devices in real time.  
The left most panel of DeviceAnywhere Studio is the short-cut panel; clicking on the icons in this 
panel will switch views (i.e. from Device Access to Record Playback).  

 

Figure 5: Device Access  

5. DeviceAnywhere Studio Menu Bar 
Near the top of your Device Access screen, you will find the Menu Bar. The available options in 

the Menu Bar change based on the activity in which you are engaged. The section below shows 

the Menu Bar items when you are in the Device Access view.  

 

Figure 6: DeviceAnywhere Studio Menu Bar 

5.1. File Menu 

The File menu contains the following entries:  

5.1.1. MyDeviceAnywhere 

You can click MyDeviceAnywhere from the File menu to get to the 
MyDeviceAnywhere website. You will automatically be logged in to 
MyDeviceAnywhere. 

5.1.2. Options 

This menu item allows users to set the size of the cache for recorded device 
activity. A certain amount of past results are automatically cached in 

DeviceAnywhere Studio (these results can be viewed through using the 
Device Video Controls at the bottom of the device (see Section 7 for details). 
Note that raising the cache size may have an impact on the performance of 

your system.  
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5.1.3. Exit 

Use Exit to close DeviceAnywhere Studio. The X button on the top right of 
the window can also be used. 

If any devices are acquired when you try to exit DeviceAnywhere Studio, you 
will see the following dialog box: 
 

 
Figure 7: Release Devices  

Selecting the Release Device(s) option releases the device(s) immediately. 

The Retain Devices(s) option retains the device(s) for 30 minutes of 
inactivity. If you then re-launch DeviceAnywhere Studio, the device will still 
be acquired. If for some reason you do not launch DeviceAnywhere Studio 
within the next 30 minutes, the device will automatically be released, and 

will be accessible to another user. 

 

5.2. Mode Menu 

 

Figure 8: Mode Menu 

The Mode Menu allows you to choose the mode of keyboard entry into the device. 
Each device’s keys are mapped to computer keyboards, for convenient text and 

numerical entry. Switching between the available modes allows your system to send 

the correct series of keystrokes to the device, to enter numbers, text or URL 
addresses as required. 

The three modes available are (1) Alpha, (2) Web and (3) Numeric. The Alpha mode 
allows you to enter alpha-numeric characters; use when entering text such as a text 

message. Some devices have a different key mapping when they are accessing the 
Web. The Web mode switches the key mapping to accommodate such a change; use 

when entering a URL. Use the Numeric mode when you only need to enter numbers 

(i.e. a phone number). 

 

5.3. Audio Menu 

Use this menu to enable or disable Audio input and output for the device. See the 
Device Interaction section for more details about audio functionalities.  
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Figure 9: Audio Menu  

5.4. View Menu 

Use the View Menu to switch between the editors of DeviceAnywhere Studio. This 
menu provides the same functionality as the shortcuts bar that you see on the left 

(vertical) side of DeviceAnywhere Studio. 

 

Figure 10: View Menu 

5.4.1. Show Shortcuts 

This option shows or hides the Shortcuts panel on the left. 

5.4.2. Show Status bar 

This option shows or hides the Status bar at the bottom of the screen. 

5.4.3. Show Device Access 

This option switches the view to the Device Access editor. 

   

5.4.4. Show Record Playback  

This option switches the view to the Record and Playback editor. This feature 
is new in 4.0. See the section below on Record and Playback for more 
information. 

5.5. Help Menu 

The Help Menu provides access to this User Guide and the latest Release Notes. This 
menu also allows you to enable and disable information popup.   
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5.5.1. Open User Manual 

This option opens the current DeviceAnywhere Studio User Manual in a 
separate window. 

5.5.2. Open Release Notes 

This option opens the current release notes in PDF format. 

5.5.3. Report an Issue 

This option allows users to report issues to the support team. 

5.5.4. About 

This displays the DeviceAnywhere Studio’s copyright notice, version number 
and other information about your installation of DeviceAnywhere Studio. 
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6. Device Access Overview 

6.1. Device and Package Display 

In the Device Access view, you will see the list of the packages that your account has 
access to in a drop-down menu. The devices within the selected packages will be 

displayed in the device pane.  

 

Figure 11: Package List and Device Pane 

Device availability is shown via an icon on the top right of each device; green checks 

indicate available devices; red circles indicate devices that are in use.   

 

Figure 12: Device Availability Indicator 



  DeviceAnywhere User Manual 4.1 

 

Copyright 2004 – 2008 Mobile Complete Inc. 
All Rights Reserved 

19 

6.2. Access Menu 

 

Figure 13: Acquiring a Device  

You can reach the Access Menu by right-clicking on a device in the device pane. The 
Access Menu options are as follows: 

6.2.1. Access Device 

Right-clicking on any device will reveal the Access menu. By selecting 

Access Device -> Acquire Device, you will acquire the device and 

prevent other users from accessing it until you release it. If you already have 
acquired a device, selecting Access Device -> Release Device will release 

the device. 

In case a device is acquired by another user, you can select the Access 

Device -> Wait For… option. Once the previous user releases the device, 
the device will automatically be acquired by the first person in the queue. 

6.2.2. Properties 

Choosing Properties from the Access Menu will open Device Properties. 
These features are described in more detail below in Section 6.3.10. 
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6.3. Device Menu 

 

       Figure 14: Device Menu 

Once a device is acquired, you can access the Device Menu by right-clicking on the 

device image either in the main window, or in the device pane. Note that Access 

Device, Share Device, Hardware Control, Properties, and Audio menu items are also 
available as short-cut icons found near the top right corner of the acquired device.  

 

Figure 15: Short-cut Icons  

The Device Menu options are as follows: 

6.3.1. Access Device 

The Access Device option allows you to release an acquired device. Once 

you release the device, another user may acquire the device, or if there is a 
queue, the next user in the queue will be granted access to the device.  
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Figure 16: Access Device 

6.3.2. Share Device 

The Share Device option allows you to share a device view with other users 

who are currently logged in. This enables other users that you invite to view 
your interactions with the device. More details on sharing a device are 

provided in Section 9. 

NOTE: When you share a device, other users may not interact with the 

device themselves and may only view the device as you interact with it. 

6.3.3. Color Depth 

The Color Depth option allows you to select the number of colors you want 

to view on the device screen. Over a slow bandwidth connection, you may 

find it useful to reduce the number of colors to improve response time. 

 

Figure 17: Color Depth 



  DeviceAnywhere User Manual 4.1 

 

Copyright 2004 – 2008 Mobile Complete Inc. 
All Rights Reserved 

22 

6.3.4. Hardware Control  

 

Figure 18: Hardware Control 

The Hardware Control option allows you to control hardware features of 
the device that are not controllable by the software. Depending on the 

phone, these options include: 

i. Disconnect Power: Enables you to connect/disconnect the device charging 
cable. 

ii. Disconnect Battery: Enables you to connect/disconnect the battery. 

iii. Turn On Camera Light: Enables you to illuminate a clock located in the 
camera’s view that you can then take a photo of, to test camera 
functionality. 

iv. Connect Data Cable: Enables you to connect/disconnect the data cable. 

v. Close Flip Phone: Enables you to open and close a clam shell-style phone, 
slide a candy bar-style phone, change to alternate screen for dual screen 

phone, or flip or rotate phone, for devices that support these actions. 

6.3.5. Audio 

The Audio Control option allows you to control speaker, recording and audio 
buffer features of the device. Depending on the phone, these options 

include: 

i. Speaker Enabled: Enables you to turn on speaker audio. Note that you 
may also need to adjust the volume controls on the device itself. The 

volume controls are typically found on the side keys of a device. 

ii. Speaker Disabled: Enables you to turn off speaker audio. 
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Figure 19: Audio Speaker 

iii. Recording Enabled: Enables you to turn recording ON through microphone 
during a phone call. 

iv. Recording Disabled: Enables you to turn recording OFF through a 
microphone during a phone call. 

v. Options: Enables adjustment of audio buffers. Increasing the size of the 
audio buffer will improve the audio quality by mitigating delays due to 
Internet latency.  In the Audio Options dialog box, you may adjust the 

Audio Output Buffer Size, Buffer Multiplier and Total Buffer Size. 

 

Figure 20: Audio Options, Buffer Properties 

6.3.6. BREW  

If the acquired device supports BREW, the device menu will include a BREW 
option, which allows users to upload BREW files to the device. This 

functionality is described in detail in Section 10.2 below. 

6.3.7. Export 

The Export option allows you to export the device screen output.  
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Figure 21: Export 

The three Export options under this category are: 

i. Current Frame: Allows you to save the device screen’s current image. 

ii. Upload Frames: Allows you to upload a set of sequential frames to 
MyDeviceAnywhere. 

iii. Generate Movie: Allows you to generate a QuickTime movie of a 
sequential set of frames.  

 
Section 8 provides more detail on exporting frames. 

 

6.3.8. Cut and Paste 

Users may Cut and Paste into a device text or number entry screen.  

 

Figure 22: Cut and Paste 

In order to use Cut and Paste, first select the required text through your 
standard operating system (i.e. Copy). Then go to the screen where you 

want to enter the text and select Paste From Clipboard. Make sure to 
choose the correct Keyboard Mapping (Alpha for text, Numeric for numbers, 

and Web for URL entry). The text will then be entered into the device. 
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6.3.9. Multiple Key Mapping 

Some devices support Multiple Key Mapping, which allows users to program 

keyboard function keys (e.g. F5) to correspond to simultaneous device key 
presses.  

 

Figure 23: Multiple Key Mapping 

To create a multiple key mapping, select a function key from the drop down 
menu, and then click on the keys in the device image that you want to map 

to the function key. 

6.3.10. Device Properties 

The Device Properties option opens a window that displays different property 

values for the device.  
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Figure 24: Device Properties 

 

The Status view shows any currently knows issues with the device, (also 

viewable by placing your mouse on the comments icon, a blue circle with a 
white exclamation point in the middle, found next to the device icon in the 

device pane) and may also provide tips on using the device. 

 

Figure 25: Device Properties: Status 

7. Device Video Controls 

DeviceAnywhere Studio automatically caches a certain amount of device activity. You can 
increase or decrease the volume of cached results through the File>Option menu. See Section 
5.1.2 above for details.   

Any frame presented on the acquired device’s Liquid Crystal Display (LCD) is recorded as a part 

of the device session. At any point, users can navigate between the previously captured frames 
of the acquired device using the Video Control Recorder (VCR) commands. For long sessions (i.e., 

many frames), where frame-by-frame navigation becomes too slow, the VCR Slider tool can be 
used to move quickly between frames. 

 
SIM Information 

for the device 

 
See below 

 
Device Type 
contains the device name 
and description 
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Figure 26: Device Video Controls 

 This button plays the recorded sequence of events backward. 

 This button moves the recording backward by one frame. 

 This button moves the recording forward by one frame. 

 This button plays the recorded sequence of events forward. 

 This button pauses the recording. 

 This button resets the device image to show live video. 

  

8. Exporting and Viewing Saved Frames 

8.1. Exporting Results 

You can export what you see on the device screen in two different formats: video 

and images. Access these options by right-clicking on the device and selecting the 

Export Menu. The Export Menu gives you three exporting options: 
i. Current Frame 

ii. Upload Frames 
iii. Generate Movie 

Video Control Bar 
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Figure 27: Export  

8.1.1. Current Frame 

The Current Frame option allows you to save one frame at a time to your 
local machine. You can export historical frames by using the Device Video 

Recorder (DVR) controls to rewind to the desired frame.  

 

Figure 28: Export Current Frame  

8.1.2.   Upload Frames  

Use the Upload Frames option to upload a set of frames (in the DVR 
memory) to MyDeviceAnywhere. Using the available controls, you can 
choose any frames to be part of the set, including non-sequential frames. 
Note that users may upload up to 50 frames to MyDeviceAnywhere at one 
time.  
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Figure 29: Upload Frames  

The options under Upload Frames include: 

i. Upload Frames: Uploads the selected frames to MyDeviceAnywhere.  

ii. Cancel: Closes the Upload dialog. 

iii. Upload Message: Allows you to enter the name of the uploaded set. 

iv. Upload Status: Allows you to set the status of the uploaded set (Success 
or Failed). 

v. Include All Frames: Allows you to upload all the frames currently in the 
DVR memory. 

vi. Remove to Left: Prevents frames to the left of the currently selected 
frame from being uploaded. 

vii. Remove Frame: Prevents the selected frame from being uploaded. 

viii. Remove to Right: Prevents frames to the right of the currently selected 
frame from being uploaded. 

 

After the frames are uploaded, a prompt appears asking if you would like to 

view the frames. 

 

Figure 30: View Uploaded Frames 
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If you select “View Now,” you will be directed to MyDeviceAnywhere, where 
all uploaded frame results are stored.  

8.1.3. Generate Movie 

The Generate Movie option allows you to generate a movie of your 

selected frames. Right-click on the device, select Export, and then select 
Generate Movie. 

 

Figure 31: Export, Generate Movie 

The Generate Movie dialog box will appear. To mark the Start Frame, right-
click on a frame and select Mark Start. To mark the End Frame, right-click 

on a frame and select Mark End. 

 

Figure 32: Generate Movie  

When you click on the Generate Movie button, a Save File dialog box will 

appear. This enables you to save your movie to QuickTime and AVI format. 
You will be asked for the name, format and location where you want to save 

the generated movie.   
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Figure 33: Save File 

After clicking the Save button, the progress of your movie generation 

process will be displayed, as shown below. 

 

Figure 34: Movie Generation Process 

When the movie is successfully generated, you will have the option to play it. 

 

Figure 35: Play Video  
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8.2. How to View Uploaded Frames in MyDeviceAnywhere 

When you log in to MyDeviceAnywhere, you can view your uploaded frames through 
the Uploaded Frames tab. This tab also provides the functionality to share results 
and collaborate with other users.  

 

Figure 36: Uploaded Frames, Framesets  

Click on the Name to view the uploaded frame details. 
 

Upload Frame Details displays a summary of the recorded frames and each frame’s 
image, time, and associated key presses.  

  

Figure 37: Uploaded Frame Details  
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9. Sharing Devices 

 

Figure 38: Share Device 

With the Share Device option, DeviceAnywhere Studio enables other users to view the device(s) 
you are currently using through their own computer. To access the Share Device option, right-

click on the device and select “Share Device” from the Device Menu, or click on the Share 

Device option in the Context Menu (shown above). Both methods will open a dialog box. From 
this dialog box you have three options for sharing devices. You may share a device with more 

than one user at a time. 

Note that in 4.0, you may elect to share a device with a DeviceAnywhere user from a different 

account. This enables partner companies with separate accounts to work together. However, no 
user from a different account will be able to view your device unless you expressly invite them as 

detailed below. 
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Figure 39: Invite Users 

9.1. Option 1: Generate Code 

Selecting Generate Code will generate a numerical code that you may then verbally 

share with other users, or manually email to them. Upon receiving the code, the user 
may enter it by right-clicking on Shared Devices in the Device Access menu at the 

top left of DeviceAnywhere Studio, and selecting Enter Code.  A dialog box will 
appear where you may enter the code.  
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Figure 40 

This option is useful when you are chatting with or already speaking to another user 

over the phone.  

9.2. Option 2: Send Email 

Entering email addresses and selecting Send Email will automatically send an email 

with a code and instructions on how to view the shared device to another 
DeviceAnywhere user. The user(s) receiving the email would follow instructions 

above on entering the code. 

9.3. Option 3: Select from a List of Users 

You may select users from the existing list of users to invite to share your device. 

Note that only users from your account, who are currently logged in to 
DeviceAnywhere Studio, will appear on this list. The user will then see a pop-up 
invitation appear in DeviceAnywhere Studio. 

 

Figure 41: Device Monitoring Invitation 

This is the most convenient way to invite other users; however, as mentioned above, 

it cannot be used to invite users on different accounts, thus ensuring that a random 

user may never be invited to see your proprietary work by mistake.  

9.4. Sharing Devices 

Users invited to monitor devices may accept or reject any invitation they receive. 
When users accept an invitation, they can observe (monitor) the device. Anytime 

after accepting an invitation, an observing user may click the Stop Monitoring 

button ( ) and leave a sharing session. Similarly, the user who initiated the sharing 
session may stop sharing the device at any time. 
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Figure 42: Stop Sharing Device 

9.5. Other Device Sharing Capabilities 

While you are sharing devices with other users, you can exchange messages with 
these users. Upon accepting a sharing invitation, a viewers list and a message 

window will appear on the right side of the DeviceAnywhere Studio interface.  
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Figure 43: Viewing a Shared Device 

10. Uploading Applications 

Most applications can be uploaded to the device over-the-air, either by sending a link to the 

device or by entering the URL where the application is hosted into the device’s browser. To 
facilitate over-the-air uploads, DeviceAnywhere offers a web server, called My Applications, 
where users can store their applications.  

BREW applications must be uploaded via a data cable. DeviceAnywhere Studio also allows you to 
upload BREW applications to the devices. 
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10.1. Uploading Applications Using My Applications 

To upload applications using My Applications, you must first save your application to 

the My Applications web server.  Start by clicking the My Applications tab in 
MyDeviceAnywhere.  

 

Figure 44: My Applications 

 

Click the Add Application icon at the top right of the page. 

 

 

Figure 45: Add Application 

 

Enter Application Name, Application Type and then Save. 

 

 
Figure 46: Application Information 

 

 
 

 
 

 

Click Add/Remove Files to select the files to be uploaded, and then select Add 
File. 
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Figure 47: Add File 

Browse to your file and select Save to upload your files.  For Java applications, you 
should upload your jar and jad files, as well as any other files required to download 

your application. 

 

 
Figure 48: Upload Files 

Next launch the DeviceAnywhere Studio application, and acquire the device that you 
want to install your application on. 

To install your application from the My Applications tab of MyDeviceAnywhere, you 
can navigate to the following URL using the device browser: http://ma.dap.md/a. 

Alternatively, you can click on the My Applications icon shown below, and once you 

have navigated to the phone’s URL entry form, the URL will automatically be entered 
for you. 
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Figure 49: Navigate to My Applications 

Next, login to the My Applications page in the mobile browser with your 

DeviceAnywhere username and password. 

My 

Applications 

Icon  
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Figure 50: Add Application 

Select your application and download it to the device. 

         

Figure 51: Add Application 

10.2. Uploading Applications to BREW Devices 

BREW applications must be uploaded over a data cable. DeviceAnywhere offers this 
capability through the BREW menu in DeviceAnywhere Studio. To get started, right-
click on the device and select BREW. You may then reset the device, upload an 

application, delete an application, download an application, view applications and 

view memory status.  
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Figure 52: BREW Menu Option 

10.2.1. Reset Device  

Once you have uploaded your application, the Reset Device option will 
power cycle the device so that you can then view your uploaded applications. 

 

Figure 53: Reset Device 

 

Figure 54: BREW Device Reset 
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10.2.2.  Upload Application 

The Upload Application option enables you to upload the applications to 

the device. 

 

Figure 55: Upload Application 

In Upload Application, you can enter the name of the application to be 
uploaded (case-sensitive). Note: please ensure that the name of your 

application corresponds to your .mod file. Next, you will be prompted to 
select the local directory that contains all application files.  

 

Figure 56: Upload BREW Application 

Once the application is uploaded, you should see the screen shown below. 

Click “Close” to close the popup. 
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Figure 57: Upload BREW Application: Successful 

10.2.3. Delete an Application 

The Delete Application option enables you to delete the applications from 

the device. 

 

Figure 58: Delete BREW Application 

To delete an application, enter the name of the application to be removed 
(application name is case sensitive). Note: to verify that your application has 

been deleted, you will need to power the device off and then on to view your 

changes.  
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Figure 59: Delete BREW Application 

 

Figure 60: Delete BREW Application Status Bar 

10.2.4.  Downloading Application 

The Downloading Application option enables you to download an 
application from the device. 

 

Figure 61: Downloading Application 

Type the name of the file you want to download (case sensitive, and 

corresponding to the .mod file), and then enter the name and path of the file 
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in the popup. Note: you will only be able to download applications that you 

have uploaded yourself. 

 

Figure 62: Download BREW File 

10.2.5.  View Applications 

The View Applications option allows you to view available applications. 

 

Figure 63: View Applications 

 

Figure 64: View Applications Status Bar 
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10.2.6. View Memory Statistics 

The View Memory Statistics option enables you to view the memory 

status of the device. 

 

Figure 65: View Memory Statistics 

 

Figure 66: View Memory Statistics Status Bar 
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RECORD & PLAYBACK 
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11. Record and Playback 
DeviceAnywhere Studio now includes Record and Playback functionality. This easy-to-use script 
creation feature allows users to record a series of steps on a device, called scripts, which are 
saved and can be edited and then re-played at any time. Each step displays the entered keys, as 

well as the corresponding screen and time from last key press. 

  

Figure 67: Record and Playback Interface 

11.1.  Record and Playback Controls 

Record and playback controls are provided as icons on the toolbar.  

 

The Record and Playback toolbar has five controls: 

11.1.1.  Play Script 

This control executes a script. Play Script is disabled when a script is 

already executing. 

11.1.2.  Pause Script 

This control enables pause of an execution of a script. Pause Script is only 
available during script execution. 

11.1.3.  Stop Script 

This control stops the execution of a script. Stop Script is only available 

during script execution. 
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11.1.4.  Restart Script 

This control allows you to restart the execution from the beginning of the 

script. Restart Script is available during script execution. 

11.1.5.  Record Script 

You can record a script simply by interacting with the device. Click on 
Record Script, and a recording light will blink on the button indicating that 

recording has begun. All your interactions with the device will be recorded as 

a script. To stop the recording, simply press the recording button again. 
The blinking light will stop, indicating the recording has been stopped. 

 

11.2.  Record and Playback Commands 

11.2.1.  Wait Image 

The WaitImage command waits for an image to appear or time out if the 
image is not found. The WaitImage command can wait for the entire 

screen to match, or can search for a subsection of the screen. Typically it is 

best to choose a subsection of the screen, as icons that for instance display 
the time and network strength meters constantly change, so should be 

excluded from an image match command.  

 

To select a subsection of the device screen as the image to compare, use 

your mouse to outline the selected region of the screen.  

To clear the selected region, press the Selection button. 

 

When a subsection of the image is selected, you can search for that 

subsection at any location in the image. Choose the Any Position radio 
button to scan the entire image for a match. 
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11.3.  Getting Started with Record and Playback 

 

Figure 68: Record Playback  

 

i.  Create a new script by right clicking on the scripts icon in the project tree (see 
image below). Note that all scripts are part of a “Project”. A default project will 

automatically be created for all accounts. Account Admins may create new projects, 
which are used to organize work and control user access to groups of scripts. New 

project may be created in the System Admin tab in MyDeviceAnywhere. 

 

Figure 69: Record Playback- New Script 

ii.   Click on script name and then add a device to the script by selecting the device 
and right clicking on the device (see image below). 

Click on this Icon 
for Record and 

Playback  
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Figure 70: Record Playback- Add Device to Script 

iii.   The device is added to the script and is now ready to start recording. 
   Note: you must also acquire the device, in order to be able to record in  

   the script. 

 

Figure 71: Record Playback — Ready for Recording 

iv.   Click on the Record Icon on the toolbar. The recording of the scripts will  

   start now. 

 

Figure 72: Record Playback — Toolbar, Start Recording 

v.   Click on the desired series of steps in the device on the right hand side 

   pane. All keys are recorded and displayed in the middle pane with   
   images including the wait time between the recorded steps. 

 

vi.   Double click on any of the recorded steps in the middle pane to display  
   a pop-up. You can edit the parameters here (see image below). 
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Figure 73: Record Playback — SendKeys Pop-up 

vii.   You can also edit the wait time between steps by single-clicking on the 

   time and editing directly (see image below). 

 

Figure 74: Record Playback — Edit Wait Time 

 

viii.   Click on the WaitImage icon to add an image to the script. 
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Figure 75: Record Playback- Wait Image 

ix.   Double-click on the WaitImage step to edit the properties for Image to 

   be captured. You can use your mouse to capture the required  
   part of the desired image to compare. Note that you can also either                                                

   select a Fixed Position comparison, requiring that the image region  
   appears in the exact position on the screen, or you may select an Any  

   Position comparison, to search for the image region anywhere on the  
   device screen. 



  DeviceAnywhere User Manual 4.1 

 

Copyright 2004 – 2008 Mobile Complete Inc. 
All Rights Reserved 

55 

 

Figure 76: Record Playback - Wait Image Properties 

11.4.  Play Script 

Select the script name to be played and click the Play button . Each step is 

executed and visible on the screen.  

 
Whenever you complete running a script, you will see a Script Successful message or 

a Script Failure message. The message dialog box gives you the option to upload 
results to MyDeviceAnywhere. These results can be found in the Test Results tab.  
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MYDEVICEANYWHERE 
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12. MyDeviceAnywhere 
 

MyDeviceAnywhere is the Web interface you see once you have logged into your 
DeviceAnywhere account. You can launch the DeviceAnywhere Studio from this interface, as well 
as perform the following functions: 

i. Collaborate with your teams, partners and customers 

ii. View test results 

iii. Make reservations for devices 

iv. Perform various administrative functions 

 

12.1. Logging In to MyDeviceAnywhere 

 
Go to DeviceAnywhere.com, and use your username and password to log into 

MyDeviceAnywhere.  

 
 

 

Figure 77: MyDeviceAnywhere – Login  

Upon logging in, users will see the Home screen of MyDeviceAnywhere.  

 

Figure 78: MyDeviceAnywhere Home Page 
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12.2.  Site Map of MyDeviceAnywhere 

 

Figure 79: Site Map  
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12.3.  Main Functionality 

On all pages of MyDeviceAnywhere, users have access to the following functionality: 

 

Figure 80: Main Functionality 

12.3.1. Request Device 

If users are interested in a device that is not currently offered in 

DeviceAnywhere, they may request it by clicking on this icon. 

12.3.2. Report Issue 

Users may report any issues with devices, the DeviceAnywhere Studio, or the 
website here. All issues are addressed by our 24X5 support team. 

12.3.3. Change Password 

Users may change their password. 

12.3.4. Logout 

Selecting Logout will log you out from MyDeviceAnywhere. 

12.3.5. Launch DeviceAnywhere Studio 

Clicking on this button will launch DeviceAnywhere Studio. 

12.4. Home 

On the Home page, users will be able to see their current packages and individual 

usage for each package. In addition, there is an announcements section, as well as a 

resources section, which includes links to the most current version of release notes 
and the user manual. Other links include the DA Forum and the DA Blog. 

12.4.1. Individual Usage History 

Clicking on the Individual Usage History navigation link on the Home page 

will show users their usage history, by month. Choosing an individual month 

will show detailed usage by device. 
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Figure 81: Individual Usage History – Summary 

 

Figure 82: Individual Usage History – Detail  

12.5. My Account 

My Account lists your accounts current subscriptions, and if you are an Account 

Admin, allows you to add or change your subscriptions. 
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Figure 83: My Account  

12.5.1. Credit Card Information 

Clicking on this navigation menu item under the My Account tab will allow 
Account Admins to edit the credit card on file. 

 

Figure 84: My Account Menu 

12.5.2. Usage History 

Similar to Individual Usage History under the Home tab, this page shows 
usage history, but of your entire account. Clicking on an individual month will 

show detailed reports by user and device. 

 

Figure 85: Detailed Account Usage by User        
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Figure 86: Detailed Account Usage by Device Detail 

12.5.3. Invoices 

Account administrators will be able to view their monthly invoices by clicking 

on this menu item. 

12.6. Uploaded Frames 

Users may use the Uploaded Frames section to share and collaborate with other 

users. The main page will show the list of framesets that you have uploaded.  

 

Figure 87: Uploaded Frames 

To view frameset details (i.e. individual frames and keystrokes) click on the 
frame name.  On this page you will be able to: 

� View Individual Frames: Details the actual frames and their associated 

key presses. 
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� Make Comments: Users may add their comments to the framesets. The 

comments are maintained in a comment history table displayed at the 

end of the page. 

� Email Results: Allows results to be emailed to users. Emails to users that 

are part of your DeviceAnywhere account will include a link to the 
Uploaded Frames page; they will be required to log in and can then view 

the results and use the other MyDeviceAnywhere functionality. Emails to 
users who are not on your DeviceAnywhere account or to non-users will 
contain a link that will only show the specific framesets you have sent. 

 

 

Figure 88: Uploaded Frames Details Page 

12.7. My Applications 

Users may use My Applications to store applications that they want to later upload to 

DeviceAnywhere devices. This functionality is described in detail in Section 10.1 
above. 

12.8. Test Results 

Scripts that are run (through Record and Playback) generate Result sets that are 
accessible through MyDeviceAnywhere. Each test result is a step-by-step Web view 
of what happened during the test run. Web-based access to test results allows you 
to view results and provides helpful sharing features. 

 

Test results are structured as follows:  

i. Each run generates a Resultset, consisting of one or more individual results.  
ii. Each result corresponds to a combination of one script and one device.  

iii. Each result is comprised of a series of result steps that present a visual view 
of what happened during that test run. 

The Test Results page displays a list of all the test results in the system, for all 
projects to which you have access. Note that test results for projects you do not 

have access to will not be shown here. 

You can sort the list of test results based on various test attributes, and you can 
navigate pages by clicking on the page numbers in the top-right corner. When you 
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click on a particular Resultset name, you will drill-down to a view showing details of 

that Resultset, including a list of the results contained in that Resultset. 

 

 

Figure 89: Test Results 

12.9. Reservations 

Reservations allow you to reserve mobile devices for usage at requested days and 
times. Reservations can be made up to 2 weeks in advance, and for up to a one hour 

slot.  

If another user is using the reserved device at the time that the reservation starts, 
they will be warned above the upcoming reservation 5 minutes before the reserved 

time. At the reserved time, the device will automatically be released and the reserver 

will be notified that the device is available for them. 

Devices can be reserved through the Reservation tab in MyDeviceAnywhere. To 
reserve a device, select Create Reservation from the Reservation menu.  

 

Figure 90: Create Reservations 
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To make a reservation, choose the package and device you want to reserve, and 

then choose the reservation time. The Device Availability Matrix will show you what 

times are available for the device.  
 

You can view your reservations through the Current Reservations menu. 

 

Figure 91: Current Reservations 

12.10. Device Search 

Device Search in MyDeviceAnywhere is new in 4.0. This tab allows users to search 
for devices by package, manufacturer, and model, similar to the Device Search page 

on the DeviceAnywhere.com website. Additionally, the Device Search inside 
MyDeviceAnywhere allows users to export their search results to an excel file.  

Users may view devices both without icons (which results in faster search results) 

and with icons. 

 

Figure 92: Device Search Results, No Icons 
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Figure 93: Device Search Results, with Icons 

Additionally, users may now search across all packages for a specific device model; 

the results will list the packages which contain that model. In the below example, the 
Motorola K1 search results are shown.  

 

Figure 94: Specific Model Search 

12.11. System Admin 

System Admin contains views for the administration of users, devices and projects. 
Only Admins and System Admins have access to this tab.  

12.11.1. Users 

This tab shows all users on your account. From this screen, you can add new 

users, add user groups, and send messages to users. 
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Figure 95: System Admin, Users 

Clicking on Add User takes you to the Add User screen. When adding a user, 

you must choose a Role. The options are User, Admin, or Account Admin.  

Account Admins are the highest level of user, with access to all 

MyDeviceAnywhere functionality. Only Account Admins may make changes 
to the account, including adding or changing subscriptions and editing credit 

card information.  

Admins (and Account Admins) may create new users, projects (used for 
managing Record and Playback scripts), and edit allowances. 

 

Figure 96: Add User 

12.11.2. Devices 

Through this tab, you may view all devices in your packages to see which 

are in use and who is using them, and you may view and create 
reservations. For more information on creating reservations, see Section 

12.9. 

12.11.3. Adjust Allowances 

Allowances are monthly limits that you place on the hours of device usage 

certain users are allowed. Note that once a user has reached their monthly 
allowance limit, they will not be able to access devices for the remainder of 

the month. 

On the Adjust Allowances screen, choose Edit. From the following screen 
(shown below) you may adjust users’ allowances by changing the hours and 

minutes in the Policy column. 
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Figure 97: Allowances, Edit Allowances 

12.11.4. Projects 

Projects help you organize scripts (see Section 11.3). In addition, projects 
may be assigned to specific users, so that Admins may limit access to certain 

projects if desired. 

To create a new project, select Add Project . You will be required to 

provide a project name, and to assign users to the project.  

 

Figure 98: Add Project 

13. Contact Information 

If you have any questions about how to use any of the DeviceAnywhere features, or have an 
issue to report, please contact us at DASupport@deviceanywhere.com. 

For questions about additional products, your account, invoices or pricing policies, please contact 

DASales@deviceanywhere.com.   

 


